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NPPW 2023 Main Images 
> Find these images in PIPER here.

PROFILE IMAGE

Possible uses for this image include:
•	 FB profile picture (jpg)
•	 Twitter profile picture (jpg)
•	 IG profile picture (jpg)
•	 Insert into a newsletter or webpage 

(jpg)

MAIN SQUARE

Possible uses for this image include:
•	 Facebook (FB) posts (jpg)
•	 Twitter posts (jpg)
•	 Instagram (IG) posts (jpg)
•	 Insert into a newsletter or webpage 

(jpg)

MAIN BANNER

Possible uses for this image:
•	 FB cover photo (jpg)
•	 Twitter cover photo (jpg)
•	 Web banner (jpg)
•	 Newsletter header (jpg)
•	 Twitter posts (jpg)

Note: This banner was designed for centers to customize by adding their own center logo! Please see 
instructions below.

https://piper.filecamp.com/s/OsCFm26cNnE1RNn7/fo
https://piper.filecamp.com/s/WjvfTMuDoV9HhaSQ/fo
https://piper.filecamp.com/s/2FNymnJ2T7rpedhE/fo
https://piper.filecamp.com/s/TEQwg8S93rZJbgwd/fo
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Adding your own logo to the NPPW banner 
For 2023, we encourage centers to add their logo to the banner only. Below are several ways to do that:

POWERPOINT 
We have provided a PowerPoint file of the NPPW banner. This is the easiest way to add your own logo. 
Follow these simple steps:

1.	 Open the file in PPT.

2.	 Make sure your center logo is saved in your Pictures. Then click on Insert and then Picture.

3.	 We have designed a blank space next to the Poison Help logo. This should work for all individual 
center logos despite the differences in shape and size. If you don’t think your logo fits well in the 
designated area, place your logo wherever it fits best.

4.	 Save the file as a PDF or a JPG for use on web/social media.

JPG AND PDF 
These can be edited to include your own logo. We recommend using 1) Photoshop or 2) Acrobat Pro. 
Programs such as Canva can also be used to add your logo. Please pay attention to make sure the color 
mode of your own logo matches that of the file.

PHOTOSHOP
Utilize the program’s “Place” and add your logo to the files. Follow these steps:

1.	 Open Photoshop and click “File” > “Open” and locate the photograph or artwork file you want to add 
your logo to. Click “Open.”

2.	 Navigate once again to the “File” menu and select “Place.”

3.	 Find the image or artwork file containing your logo, click on it, and click “Place.”

4.	 Once the logo is sized and moved to the right location on the original document, press the “Enter” 
(“Return” for Mac users) key to commit to the current placement.

ACROBAT PRO
Acrobat can place the following image types directly on a page:  
JPEG (.jpg), Bitmap (.bmp), GIF (.gif), TIFF (.tif), PCX (.pcx), PING (.png)

Follow these steps to import and place an image on a PDF:

1.	 Open the PDF file on which you want to place the image.

2.	 Choose “Tools” > “Advanced Editing” > “Touchup Object Tool.”

3.	 Right-click and choose “Place Image.” Select an image file and click “Open.”
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Sample social media posts for use with 
main image and banner (English and Spanish)

SAMPLE SOCIAL MEDIA MESSAGES (for use with the main square and main banner images) 
We strongly recommend using #NPPW23 on all posts.

ENGLISH SPANISH

SAVE THE DATE! National Poison Prevention Week 
will be here sooner than you think! Join us in a 
celebration of safety from March 19-25, 2023. When 
poison happens, we’re here for you. #NPPW23

¡MARCA TU CALENDARIO! ¡La Semana Nacional 
de Prevención de Envenenamientos llegará 
antes de lo que piensas! Únete a nosotros en la 
celebración de la seguridad del 19 al 25 de marzo 
de 2023. Cuando hay algún envenenamiento, 
estamos aquí para ayudarte. #NPPW23

This year’s National Poison Prevention Week is 
March 19-25, 2023! More to come! #NPPW23

Este año, la Semana Nacional de Prevención de 
Envenenamientos es del 19 al 25 de marzo. ¡Más 
por venir! #NPPW23

March 19-25, 2023 is National Poison Prevention 
Week. Poison happens. When it does—we’re here 
for you. #NPPW23

Del 19 al 25 de marzo es la Semana Nacional 
de Prevención de Envenenamientos. Las 
intoxicaciones ocurren. Cuando ocurran, estamos 
aquí para ayudarte. #NPPW23

Poison happens to people of all ages. That’s why 
we’re here for *everyone*. When poison happens, 
we’re here for YOU. #NPPW23

El envenenamiento afecta a personas de todas 
las edades. Por eso estamos aquí para *todos*. 
Cuando ocurran, estamos aquí para ayudarte. 
#NPPW23

When poison happens, we’re here for you. Save the 
Poison Help number in your contacts, and join us 
as we celebrate National Poison Prevention Week! 
#NPPW23

Cuando el envenenamiento ocurre, estamos aquí 
para ayudarte. Guarda el número de Poison Help 
en tus contactos y acompáñanos en la celebración 
de la Semana Nacional de la Prevención del 
Envenenamiento. #NPPW23

Poison Centers: here for you when poison 
happens. 24/7/365. #NPPW23

Centros de envenenamiento: aquí para usted en 
caso de envenenamiento. 24/7/365. #NPPW23
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Social media carousels (English and Spanish)

CAROUSEL 1: “Household cleaners looked like juice?”

CAROUSEL 2: “Double dose of medicine?”
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CAROUSEL 3: “Sting or bite?”

CAROUSEL 4: “Parenting a teen?”
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CAROUSEL 5: “Healthcare provider needing poison recommendations?”

> Find these carousels/individual images in PIPER! 
•	 For English, click here.
•	 For Spanish, click here.

There are 5 social media carousels for your use this year. Each carousel contains 5 images that tell a poison 
“story.” Each individual image is also designed to be used separately, as a stand-alone image. These are 
available in both English and in Spanish.

Feel free to use them as carousels or individual images, depending on your preferences. 

Each carousel tells a different “story”, which represent a wide range of common Poison Center calls and 
exposures for people of all ages:

•	 Household cleaners looking like juice to a child
•	 Older adult medicine mix-up 
•	 Bite/sting
•	 Teen medicine misuse
•	 Guiding other healthcare providers 

Possible uses for these images: 
•	 FB posts (jpg)
•	 IG posts (jpg)
•	 Twitter posts (jpg)
•	 Drop in newsletters (jpg)
•	 Add to websites (jpg or pdf)
•	 Share individually or together as a carousel post (suggested on FB or IG)

https://piper.filecamp.com/s/4G8cI7GxxqmONXpW/fo
https://piper.filecamp.com/s/UTvoopO4C5iAfdmK/fo
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Suggested posts for each day of NPPW 
(English and Spanish)
Below, please find suggested posts for each day of NPPW, in both English and Spanish. Each day focuses 
on an important message about Poison Centers, including a caller’s story. Please use these images/text (feel 
free to edit the post to fit your center) on the specified days to create a unified voice and amplify each center’s 
efforts.

DATE IMAGE POST (ENGLISH) POST (SPANISH)

Sunday,  
March 19, 2023
Launch Day

Main NPPW 
Graphic/
Banner

Today is the first day of 
National Poison Prevention 
Week! When poison happens, 
we’re here for you. Poison 
Centers are open 24/7/365 for 
questions and emergencies. 
Join us each day of 
#NPPW23 to learn how your 
Poison Center can help you! 
Have a story about a time we 
helped you? Share it in the 
comments.

Hoy es el primer día de 
la Semana Nacional 
de Prevención de 
Envenenamientos. Cuando 
ocurre un envenenamiento, 
estamos aquí para 
ayudarte. Estamos abiertos 
24/7/365 para preguntas 
y emergencias. ¡Únete 
a nosotros cada día 
de la #NPPW23 para 
aprender cómo tu centro 
de envenenamiento puede 
ayudarte! ¿Tienes una historia 
sobre una vez que te hemos 
ayudado? Compártala en los 
comentarios.

Monday,  
March 20, 2023

Carousel 1: 
“Household 
cleaners 
looked like 
juice?”

Kids get into…well, 
everything. That’s why you 
can ask us anything! We’re 
here for you and your little 
ones as they grow. Save our 
number when they’re little, 
use it for a lifetime: 1-800-
222-1222. #NPPW23

Los niños se meten en...
bueno, en todo. Por eso 
puedes preguntarnos 
cualquier cosa. Estamos 
aquí para ti y tus pequeños 
mientras están creciendo. 
Guarda nuestro número 
cuando sean pequeños, úsalo 
para toda la vida: 1-800-222-
1222. #NPPW23
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DATE IMAGE POST (ENGLISH) POST (SPANISH)

Tuesday,  
March 21, 2023

Carousel 2: 
“Double dose 
of medicine?” 
carousel

Poison Centers: not just for 
kids. We help adults too! Have 
a question about a medicine 
or drug? We provide 24/7 
confidential, expert advice. 
More reliable than a confusing 
internet search: 1-800-222-
1222. #NPPW23

Centros de envenenamiento: 
no sólo para niños. También 
ayudamos a los adultos. 
¿Tiene una pregunta sobre 
un medicamento o una 
droga? Proporcionamos 
asesoramiento confidencial 
y experto las 24 horas del 
día, los 7 días de la semana. 
Más fiable que una confusa 
búsqueda en Internet: 1-800-
222-1222. #NPPW23

Wednesday, 
March 22, 2023

Carousel 3:  
“Sting or 
bite?”

Bee stings, snake bites, and 
jellyfish. Oh my! The great 
outdoors is full of potential 
poisons. The good news: 
when poison happens, 
we’re here for you. Save our 
number: 1-800-222-1222. 
#NPPW23

Picaduras de abeja, 
mordeduras de serpiente 
o medusas. ¡Oh, Dios mío! 
La naturaleza está llena 
de sustancias tóxicas. La 
buena noticia: cuando el 
envenenamiento ocurre, 
estamos aquí para ayudarte. 
Guarda nuestro número: 
1-800-222-1222. #NPPW23

Thursday, 
March 23, 2023

Carousel 4: 
“Parenting a 
teen?”

It takes a village to raise a teen. 
Add Poison Help to yours! When 
poison happens, we’re here 
for you with confidential, non-
judgmental, fast, free, expert 
advice. #NPPW23

Se necesita una aldea para 
criar a un adolescente. Añade 
Poison Help a la tuya. Cuando el 
envenenamiento ocurra, estamos 
aquí para ti con asesoramiento 
confidencial, sin juicios, rápido, 
gratuito y experto. #NPPW23
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DATE IMAGE POST (ENGLISH) POST (SPANISH)

Friday,  
March 24, 2023

Carousel 5: 
“Healthcare 
provider 
needing poison 
recommend
ations?”

Did you know…healthcare 
providers call us when they need 
poison guidance? That’s right. 
We’re here for you, and all of the 
providers caring for you. When 
poison happens, we’re the go-to 
call, for you AND your healthcare 
provider: 1-800-222-1222. 
#NPPW23

¿Sabías que... los profesionales 
de la salud nos llaman cuando 
necesitan orientación sobre 
venenos? Así es. Estamos 
aquí para ti, y para todos los 
proveedores que te atienden. 
Cuando se produce una 
intoxicación, somos la persona 
a la que hay que llamar, tanto 
para ti como para tu proveedor 
de servicios médicos: 1-800-222-
1222. #NPPW23

Saturday, 
March 25, 2023 
Closing Out 
NPPW

Main NPPW 
graphic/banner

That’s a wrap on #NPPW23, 
but remember: when poison 
happens, we’re here for YOU. 
Don’t’ forget to save the Poison 
Help number: 1-800-222-1222. 
Learn more about our services 
and ways to keep your loved 
ones safe at [LINK TO CENTER 
RESOURCES/WEBSITE]. Have 
a story about a time we helped 
you? Share it in the comments!

Con esto terminamos la 
#NPPW23, pero recuerda: 
cuando algún envenenamiento 
ocurra, estamos aquí para 
ayudarte. No te olvides de 
guardar el número de ayuda 
contra el envenenamiento: 
1-800-222-1222. Obtén más 
información sobre nuestros 
servicios y formas de mantener 
a tus seres queridos a salvo 
en [LINK TO CENTER 
RESOURCES/WEBSITE]. 
¿Tienes una experiencia 
sobre una ocasión en la que te 
hayamos ayudado? Compártala 
en los comentarios.
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Social media reminders and tips 
1.	 Use #NPPW23 in every post! These can be used across Facebook (FB), Instagram (IG), and Twitter 

platforms. You can also search across social media for this hashtag to re-post or like other Poison 
Centers’ social posts.

2.	 Remember most people view social media on their smartphones. Be aware of small text: something 
that may look fine on your desktop may be hard to read on a phone screen.

3.	 Social media platforms are highly visual and the algorithms for Twitter and FB in particular prioritize 
posts with images. We’ve provided several different options, including some that can be used 
independently or as carousels, for this reason.

4.	 If you’re feeling creative with the images, try creating a carousel/video of related images or mix and 
match. We designed several carousels as part of this campaign, though the pieces of each can also be 
used individually.

5.	 Get active on your social media accounts by engaging with comments on your posts. When posts 
receive higher “engagements” (likes, comments, shares, re-posts) they are seen by more people. 
Support one another by engaging on other centers’ posts.

6.	 For FB and IG, consider using the “stories” option for posting images. Stories are posted for 24 hours 
and receive a lot of traffic from other users. If posting on a story, there’s no caption, just the image; 
however, there are fun filters and special effects that you can add. Just be sure not to include too much 
text.

7.	 For Twitter, we encourage using other appropriate hashtags to gain attention. For instance, a popular 
hashtag is #MondayMotivation which could be used in a post to share a safety step that everyone 
should take. Using a popular or trending hashtag allows even people who don’t follow your account to 
view the tweet.

8.	 Have a regular cadence for posts. Try to avoid posting 4 items in one day and then nothing the next 
day. If you can only post once a week, then stick to that.

9.	 Cross-posting is an easy way to stay on top of social media. It’s fine to post the same image and text 
(or tweak the text some) to each social media platform at the same time. There’s no need to reinvent 
the wheel for each platform.
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NPPW Council poster and video contest 
**Please note: this content is independently created by the NPPW Council.**

The National Poison Prevention Week (NPPW) Council is dedicated to promoting awareness of NPPW each 
year. The council raises awareness to poisonings, poisoning prevention, and the free Poison Help helpline. 
Council members include: corporate representatives, Poison Center educators, HRSA representatives, 
Consumer Product Safety Commission (CPSC) representatives, America’s Poison Centers representatives, 
at-large public members, public school educators and nurses, and representatives from like-minded 
organizations. 

Annually, the NPPW Council sponsors a nationwide contest and other activities to engage the community in 
helping to ensure the safety of children and adults. Students in kindergarten through fourth grade are invited 
to participate in a poison safety poster showcase, and students in grades five through twelve are invited to 
participate in a video contest. Both posters and videos are featured on NPPW Council social media platforms, 
and participants are eligible to receive prizes. 

If you have questions, please call the NPPW Council Chair, Kristin Cordz, at (503) 404-3232 or email 
NPPW@marketactives.com. 

To access the contest website, please visit: https://bit.ly/NPPW2023Contest.

https://bit.ly/NPPW2023Contest

